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4.12 Chart System

4.12.01 Applying Standard Charts

Projectile contains many standard charts. The charts are grouped by topic in the chart blocks and
contain between one and up to 13 individual charts.

The charts can be be opened in the work area by using the functionality “Charting”.

22.10.2009 [3 w

Mew Project
Lireriiie 22,10,2009 [ 5 w
prol ¥ @ v || Conner Jane v

re[| ProductChart
| Project chart l{h_-,}

In the following example various project-related charts are displayed. Included are the charts: project
overview chart, project structure diagram, target/actual comparison chart for projects and jobs,
milestone-trend-analysis (MTA) chart, completion chart, employee occupation chart, skill-matrix, and
perform report for resource planning chart.

After opening the chart type (here, the project chart) a chart document is opened. In the document
selection criteria and options for the chart can be configured.
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> (& Project chart

Generate chart
d,g B Document = Edit = Migw - 0 6’ E@ E%

InputDiata | FParameters | Faormat | Results|

1. Mame: [Frou wowle e to save g chat please enfer a deacription

Mame 4

Description Project chart

Chart ¥ ©
Feport Selection R

2. Input data: To gather aif the doclments refevant for the chart
Alease Lae the search engine (if need be repeateciivl

Search
Search word Categorny

Input data

In the first part (1. Name) a name can be given for the chart if the chart is to be saved. Saving the
chart is useful if the selection criteria of the chart remains constant, for example a list of all active
projects for the current quarter. The saved chart can then be saved are copied to the personal
clipboard or it can represent the basis for time service in order to automate the chart evaluations.
Also, the charts can be generated in the background. To view the results of the chart, the evaluation
must also be stored.

In the second part (2. Input Data) the input data of the chart is determined. In the third part (Main
parameters) the input data can be limited through a time span.

In the first example the selection criteria for the input data for two projects are selected from the
personal clipboard:

=T k::._, |_|é_'“| y Clipboard - = [ IE L_la Lu:ugu:uut

projectile Tracking and Recording 1 Open clipboard ‘{b s v gt
¥ >< I.;Eh Project chart D GoodsGaroup 1 Projectile
[ e i D ChangeRequest 3-1 Change request
dﬂ B Document »  Edit ® 0 Collection Cuery 'Projectils’ 4 6’
D Project 3 Introduction Projectile
IEUIDEE) | FEIFITEET | FOIE | i D Project 1 Introduction Projectile 2.5
1. Mame: I yiou would like to save g chab D Praject 3 Introduction Projectile
Marne 4 D Project 3 Introduction Projectile

-
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These projects are marked in the clipboard, ...

4 Personal clipboard 1

E Document = Edit Wiew »  Back references =

Entries
A page |1 ofl ey
- Desctription
1 D GoodzEroup 1 Projectile
2 D ChangeRequest 3-1 Change reqguest
3 [CJ Collection Guery Projectile’
4 D Project 3 Introduction Projectile
4 D Praoject 1 Introduction Projectile 2.5
J G D Praoject 3 Introduction Projectile
J 7 D Praoject 3 Introduction Projectile
... copied and ...
g page |1 of 1 oy
x Remove
d Cut Projectils
|:_'] Copy =t 3-1 Change reguest
ir &dd ko clipbna@ iy 'Projectile’
|E'J Create report From lisk uction Projectile
Toggle select uction Projectile 2.5
J =3 D Project 3 Introduction Praojectile
J 7 D Project 3 Introduction Praojectile

... pasted into the input data.

1-7 (D

1-7 1@
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> (= Project chart

Generate chart
dﬂ E Document *  Edit » Wiew :: &7 E@ Bél

InputDiata | Farameters | Farmat | Results|

1. Mame: fyau wowlc lice to save a chat please enter a deacription

Marme 4

Description Project chart

Chart 01 - Project overview chart ¥y @
Feport Selection w

2. Input data: To gather aif the doclments refevant for the chart
Alease Lag the search engine (if necd be repeataciiil

Search
Search word Categorny

Input data

7 Noentries -
& Paste

L) Mew document  |aea select pararmetars:

F

This process can be performed repeatedly (or with multiple entries). In the example below are ...

Input data
SET page |1 of 1 P 1-110

1 D Project 3 Introduction Prajectile

... Project 3 is the selected criteria, which is referred to in the chart.

Finally, the chart period is selected ...
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Search

Searchword | Bl

Input data

aw
i

i

i

i

E

hE]

hE]

| Current quarter
[ Current weelk

| Current year {E?_I 1@
| Last calendar ot

| Last calendar week

[l Last calendar year

| Last rmionth —

Current. manth "

| Last quarter
| Last week

| Last wear

2el | Mext calendar mionth

3. Main pararm =
Chart period |

A =

... the time span limited to the current year ...

3. Main parameters: Please aelect parametars:

Chart period Current year b
Start 01.01.2009 [3 v
End 31.12.2009 [3 v

... and the chart “job chart target/actual” generated using 4 .

> (& Project chart

Generate chart
dﬂ D Document = Edit * Wiew -

InputDiata | FParameters | Faormat | Results|

1. Mame: [Frou wowle e to save g chat please enfer a deacription

MHame
Description

Chart

Feport Selection

4
Project chart

04 - Job chart targetfactual > &

Perfarm row

If the chart results are generated, the system presents the results in the browser. This chart includes
information about the projects, activities and/or jobs and agents, the estimated and actual times with
remaining time/effort and the corresponding difference (planned - actual), the estimated processing
period (start / end) and the status information (status, completion date and completion of the task).
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Job Target/Actual
Project Job Employee Planned |Actual |Difference |Rest |Begin End Closed State

[h] [h] [h]
3 Introduction 3-1 Conception for combining Projectile | Timothy 16,00 38,00 -22,00| 0,00|09.06.2009|30.10.2009 IN_PROCESS
Projectile and SAP CO/FI Jones
3 Introduction 3-2 Installation Projectile Timaothy 3,50 16,13 -12,63| 0,00|09.06.2009|30.10.2009 IN_PROCESS
Projectile Jones
3 Introduction 3-3 Programming 4-3 Timaothy 40,00 7.28 32,72|32,72|09.06.2009|30.10.2009 IN_PROCESS
Projectile Jones
3 Introduction 3-4 Project Management Conner Jane 30,00{ 20,00 10,00{16,00(19.10.2009|30.10.2009 IN_PROCESS
Projectile
3 Introduction 3-5 3.1-1 Concept - 3 Planning Conner Jane 30,00 19,75 10,25| 0,00({19.10.2009|21.10.2009|20.10. | |
Projectile :
3 Introduction 3-6 Customizing Conner Jane 20,000 16,50 3,50| 3,50(02.10.2009(30.10.2009 IN_PROCESS
Projectile
3.1 Introduction 3.1-1 Introduction Projectile Conner Jane 0,00 7,50 -7.50|12,00|09.06.2009(01.10.2009
Accounting

139,50| 125,17 14,33|64,22

After closing the chart results, the chart block project chart is displayed again.

@ Filesek

Job Target/Actual

|F'rujeu::t |J|:|I:|

3 Introduction Projectile 35 3.1-1 Concept - 3 Planning

3 Introduction Projectile 3-b Custamizing

3.1 Introduction Accounting|3.1-1 Introduction Projectile

If the chart block is saved, the chart block can be applied as the basis for time services or for chart
evaluations in the background.

pod [BJ Project chark

Generate chart

I% Cocument *  Edit = Yiew =

InputData | Pararmeters | Fl:urrr.:c'.a‘l".e. the ?f:."f"'lme"'t

1. Mame: If ol would ke to save & chart pleass enfer & description

Mame JB0001-BE

Description Project chart

Chart 04 - lob chart targetfactual ¥ @

Report Selection

Using 6’ the charts can be started in the background.
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> (& Project chart JB0001-BB Project chart ?

Generate chart

g B Ej 1‘1 |j|] Dacument = Edit *  Yiew *  Back references = LJ|> %’ E@ B%

|F‘erF|:|rm in background i

InputData | Farameters | Format | Reault5|

1. Mame: IFroy wolld ke bo savie g chart piease entar g descrinhion

Mame JB0001-BE

The system informs the user of the background process ...

[E Your action will be performed in background

Hidle thes@messnges

.. and generates ...

= S dipboard - | ™ O @ % | (D) Logou Create .. v | [od || s=arch in docul

Tracking and Recording Offers = D Projecks = Invoices = (51 Contacks = 4}3 Human resources Admi

projectile

? & project chart JB00001-BB Project chart 7%

Generate chart

E] @ _337 ﬂ] Document *  Edit +  View »  Back references - LJ|> 6 E@ BI% T

InputData | Farameters | Faormat | Results|

1. Name: [Tyou wowld like fo save a chatt please enter a descrintion

Mame JB00001-ER
Description Project chart
Chart

03 - Project chart targetfactual ~ &

Report Selection = =

2. Input data: To gather 3l the doclments relevant for the chart
pigase Use the seatch engine (If heed he repastaciid

Search
W
Searchword Categany
M 23.10.2009 (CW 43) » S Conner Jane = |[# - @ov M P ||zearchmanual.. @3 1 1

... an internal message, as soon as the chart results are generated.
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Conner Jane, 23.10.2009 13:03:13
Action compiefad Frafect chart JR0007 -85 Frajact chart

Project chart JE0001-BE Project chart %

L4 cConner Jane, 23.10.2009 13:03:13 75 Ueiere

3
Action compiefed: Froject chart R0 -85 Frofect chart a Reply

=¥ Forward
A mail program
|jl.] References b

The message appears in the mailer and the user can access the chart results through a link:

Subject

Action completed: Project chart JBOD01-BE Project chart
Body

Project chart JBO001-EE Project chart

Feferences

r@[']t}han result D4,;\[E.jub chart targettactual Project chart 23.10.200913:03:13

0=

https://infodesire.net/dokuwiki/ Printed on 2025/04/19 02:28


https://infodesire.net/dokuwiki/lib/exe/detail.php?id=en%3Ahandbuch%3Akapitel_4%3A4.12.1_bedienung_der_standardauswertungen&media=en:handbuch:kapitel_5:project_chart17.1.gif
https://infodesire.net/dokuwiki/lib/exe/detail.php?id=en%3Ahandbuch%3Akapitel_4%3A4.12.1_bedienung_der_standardauswertungen&media=en:handbuch:kapitel_5:project_chart18.gif

2025/04/19 02:28 9/18 4.12 Chart System

X @ Chart result 04 - Job chart target/actual Project chart 23.10.2009 13:03:13 2
SRS BT A e LY
dﬂ a Eﬁ i’ ﬂ] Document »  Edit v Wiew v Back references v
Chan Froject chart JBOO01-BB Project chart
reatedAt | 22 10.2000 [ v 120313 [ v hartType g 1ob chart targetfactual Praject chart
Patameters corrment
Job Target/Actual
Project Job Ermployes Planned  |Actual  |Difference  |EstimatedRemainingEffort|Begin End Cloged State
th] hl thl
3 Introduction Projectile  |3-1 Conception for combining Projectile and SAP Timothy 16,00 38,00 -2200 0,00|09.06.2009(30.10.2009 IN_PROCESS
COfFl Jones
3 Introduction Projectile  |3-2 Installation Projectile Timaothy 3,50 16,13 -12563 0,00|09.06.2009(30.10.2009 IN_PROCESS
Jones
3 Introduction Projectile  |3-3 Programming 4-3 Tirmothy 80,00 728 7272 ¥2,72|08.06.2009(30.10.2009 IN_PROCESS
Jones
3 Introduction Projectile  |3-4 Project Management Connet Jane 8,00 20,00 -12,00 16,00/19.10.2009|30.10.2009 IN_PROCESS
3 Introduction Projectile [3-53.1-1 Concept - 3 Planning Conner Jane 30,00 1975 10,26 0,00]12.10.2009|21.10.2008|20.10.2002|IN_PROCESS
3 Introduction Projectile  |3-8 Customizing Conner Jane 0,00 16,50 -16,50 0,00/02.10.2009 (30.10.2009 IN_PROCESS
3.1 Introduction 3.1-1 Introduction Projectile Canner Jane 0,00 750 -7 A0 1200|059 062003 (01.10. 2009 IN_PROCESS
Accounting
giaaansna granann 137,80 12517 12,33 100,72

In the second example, the standard search engine is applied for selecting the input data. Here, for
example, all projects (selected category), ...

2. Input data: To gather aif the documents relevant for the chatt
piggse Wae the search engine (i need be repeatediy)

Search
w
Search word Category
Projectile Project »
Input data

i Mo entries -

... Which contain the term “Projectile” ...
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Search
W
Search word Category
Projectile Project b ,nh
Input data Find
e b page |1 of 1 e 1-9 1@
1 E Praoject 1 Introduction Projectie 2.5
2 E Froject 1.1 Planning
3 E Project 1.2 Customizing
4 E Praoject 2 Introduction Projectile 2.7
5 E Froject 2.1 Planning
G E Project 2.2 Customizing
7 E Project 3 Introduction Projectile
a E Project ¥ Update Projectile
g E Project 7.1 Introduction Accourting

... are applied as input data. Entries, which should not be applied as selection criteria are marked,
toggle selected ...

Input data

g page Il_ of 1 ot 1-9iR
x Remove

d Cut juction Projectile 2.5
E;_'] Copy nning

i: add to clipboard stomizing

[ Paste juction Projectile 2.7
|Eh Create report from lisk mning

Ej Mew document stomizing

Toggle select b Fucth:un Projectile

5 [ Proett 7 Update Projectie

W 9 D Praoject 7.1 Introduction Accounting

... and the entries are removed from the input data:
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Input data
Qg page |1_ af 1 o
x Remoe {E}
d Cut juction Projectile 2.5
|:_'] Copy nning
ir #dd ko clipboard stomizing
[ Pasts juction Projectile 2.7
|E'.] Create report From lisk Aning
Ej Mewy docurnent Etomizing
Tooggle seleck Fuu:tiu:un Projectile
v

g D Project ¥ Update Praojectils

9 D Project 7.1 Introduction Accounting

1-9(89

All entries from the selection are evaluated (not only the marked one)!

¥ (= Project chart JB000001-BB Project chart

Generate chart
dg E E.! l- ﬂ] Document *  Edit = Wiew »  Back references

InputDrata | Farameters | Format | Reaults|

1. Marme: if wau woulid like to save a chatt please enfer a description

Mame JB000001-EE
Description Project chart
Chart

Report Selection

04 - Job chart targetfactual »

2. Input data: To gather all the docuwments refevant far the chant

pizase Use the search engine (If nead be repeatediy)

Search

Search ward
Projectie
Input data
N page |1 af 1 .:_:—"
1 D Project 2 Introduction Projectile 2.7

2 D Project 3 Introduction Projectile

Category

Project

1-2(@

& QB

This process can be performed a several amount of times (with various categories). Afterwards, the
chart is generated again (in the example, job target/actual comparison for the projects 2 and 3):
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%5 Fileset 2%

Job Target/Actual
Project Jaob Employee Planned |Actual |Difference |Rest |Begin End Claged State
[h] [h] [h]
2 Introduction Projectile [2-1 Introduction Projectile 2.7 Belsito o000 o000 000 0,00)14.09.200917.09.2009 PLANMED_LATE
27 MWlarina
3 Introduction Projectile |3-1 Conception for combining Projectile and | Timothy 16,00 35,00 -22,00| 0,00(09.06.2009(30.10.2009 IN_FROCESS
SAP COFI Jones
3 Introduction Projectile [3-2 Installation Projectile Tirnaothy 350 16,13 -1263) 0,00(09.06.2009(30.10.2009 IN_PROCESS
Jones
3 Introduction Projectile |3-3 Programming 4-3 Timothy 80,00 728 7272 7272(09.06.2009|30.10.2009 IN_PROCESS
Jones
3 Introduction Projectile [3-4 Project Management Conner Jane 30,00 20,00 10,00( 16,00{19.10.2009(30.10.2009 IN_PROCESS
3 Introduction Prajectile [3-5 3.1-1 Concept - 3 Planning Conner Jane 30,00 19,75 10,25 0,00(19.10.2009|21.10.2009|20.10.2009 [FINISHED
3 Introduction Projectile |3-6 Customizing Conner Jane 20,00 16,50 A0 250(02.10.2009(30.10.2009 IN_PROCESS
3.1 Introduction 3.1-1 Introduction Projectile Conner Jane 0,00 750 -7 501 12,00(09.06.2009|01.10.2009
Accounting
179,50 12517 54,33(104,22

The third possibility to select the input data is the advanced search. The appropriate search queries
are stored here, which can be immediately applied.

2. Input data: To gather aif the dociments refevaht for the chart
pigase Wae the search engine (F heed be repeatediy)

Search

Top| v

{b Category
v/ [Q

¢ me[| Top projects (active)

Input data

o Mo entries -

In the example, all top projects with the status “active” are transfered to the input data.

Search
Top projects (active) v
Search word Category
v/ @
Input data
P pagell_l:ufl o 1-1 1

[ £ v
&

1 D Project 3 Introduction Projectile

Then, the chart period (3. main parameters) and the other criteria can be used (4. parameters) to
usefully limit the chart results. These parameters include for example, the cost center of the project,
the project type, project status, priority, and marked whether the project is an external order or not.
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The further options refer to filtering the results.
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In the example, all projects are evaluated, which are applied to the cost center “development”, a
project class as a must/shall project ...
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... as well as marked as an “external order”.
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On the “Format” tab (5. Adjustment of chart display) for example, the width of the image in pixel and

the diagram type can be selected.
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If an alternative output format is needed (by default, all charts are generated in HTML within the
application), the output format can be selected in the element “Display”.

In the following example, the chart job target/actual with the image (chart type “bar horizontal”) ...
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Depending on the system settings, the generated chart is opened in the browser ...
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... orin the appropriate display program ...
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... (here in Adobe Reader).

In the “Results” tab, the chart results are administered.
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B. Results: Here you find the resuits of charta previolsly perormed
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Fesults

Notes: The chart results are stored permanently only if the chart block is stored. The number of
results can be set in the field “Max Number of Results”.
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